MiVoice MX-ONE
Service Node Virtual Appliance - Installa-

tion Instructions

Release 7.4 SP1
April 13, 2022

00 Mitel



Notice

The information contained in this document is believed to be accurate in all respects but is not warranted by Mitel Networks ™

Corporation (MITEL®). The information is subject to change without notice and should not be construed in any way as a commit-
ment by Mitel or any of its affiliates or subsidiaries. Mitel and its affiliates and subsidiaries assume no responsibility for any errors
or omissions in this document. Revisions of this document or new editions of it may be issued to incorporate such changes.No

part of this document can be reproduced or transmitted in any form or by any means - electronic or mechanical - for any purpose
without written permission from Mitel Networks Corporation.

Trademarks

The trademarks, service marks, logos and graphics (collectively “Trademarks”) appearing on Mitel's Internet sites or in its publi-
cations are registered and unregistered trademarks of Mitel Networks Corporation (MNC) or its subsidiaries (collectively "Mitel")
or others. Use of the Trademarks is prohibited without the express consent from Mitel. Please contact our legal department at

legal@mitel.com for additional information. For a list of the worldwide Mitel Networks Corporation registered trademarks, please

refer to the website: http://www.mitel.com/trademarks.

®,™ Trademark of Mitel Networks Corporation
© Copyright 2022, Mitel Networks Corporation
All rights reserved


http://www.mitel.com/trademarks
http://www.mitel.com/trademarks

Contents

Chapter: 1 General . . . . .. e e e e e e e e e e e e e e e e e 1
Glossaryand Acronyms .. . . . . . . ... e e e 1
Chapter: 2 Prerequisites . . . . . . i i it e e e e e e e e e e e e e e e e e e 2
Chapter: 3 EXecution . . . . . . . i it e e e e e e e e e e e e e e e e e 3
Chapter: 4 Importing the Virtual Appliance . . ... ................. 4
Importing on a Single ESXi Host (From ESXi6.5) . . . . ... ....... 4
Importing on a Single ESXi host (From ESXI 6.0 Or Earlier) . . ... ... 4
ImportingintoavCentercluster. . . . . ... ... ... . ... ..... 5
Chapter: 5 Post-Configuration of a Newly Imported MX-ONEVM . . . . ... ... 6
Chapter: 6 Installing MX-ONEonHyper-V . . . . ... ... .. 7
Chapter: 7 Installing MX-ONE KVM, SUSELinux . ... ............... 18
Chapter: 8 Installing MX-ONE KVM on Redhat-Linux . .. ............. 21
Creating a VM by Importing an MX-ONE qcow2 Image . . . ... .. .. 21
Chapter: 9 Installing and Configuring MX-ONE . . . ... ............. 25

28/1531-ANF 901 14 Uen E 2022-04-13



GLOSSARY AND ACRONYMS
CHAPTER 1 GENERAL

General

This document describes the usage of the MX-ONE Service Node (SN) packed as a Virtual Appliance for
VMware vSphere/ESXi.

If an existing MiVoice MX-ONE system has used Turnkey Solution installation (with hardware), and shall
be changed into a Virtual Appliance installation, that has to be done as a new installation with Virtual
Appliance.

Glossary and Acronyms

For a complete list of abbreviations and glossary, see the description for ACRONYMS, ABBREVIATIONS
AND GLOSSARY.
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CHAPTER 2 PREREQUISITES

Prerequisites

» The vSphere Client installed on a workstation.

* VMware ESXi 7.0 host (minimum version 5.5) or a vCenter solution, recommended version is VMware
ESXi 6.7 or later shall be used.

* The MX-ONE Service Node Virtual Appliance file.
» Good knowledge of VMware vSphere.
* Good knowledge of SLES12 and MX-ONE installation.

» Read the MiVoice MX-ONE SYSTEM PLANNING description, and the description VIRTUALIZATION
FOR MIVOICE MX-ONE 7.0 or later.

NOTE: For database (Cassandra) server VMs, co-located or stand-alone, SSD disks are required.
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CHAPTER 3 EXECUTION

Execution

The procedure involves the following 3 major tasks:
1. Importing the Virtual Appliance to:

— a single ESXi host, or

— a vCenter cluster

2. Post-configuring a newly imported MX-ONE virtual machine

3. Installing and Configuring MX-ONE
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IMPORTING ON A SINGLE ESXI HosT (FRom ESXI 6.5)
CHAPTER 4 IMPORTING THE VIRTUAL APPLIANCE

Importing the Virtual Appliance

This section describes how to install the MX-ONE Service Node Virtual Appliance on a virtual machine.

Importing on a Single ESXi Host (From ESXi 6.5)

This section describes how to install the MX-ONE Service Node Virtual Appliance on a single VMware
ESXi host through the VMware host client. This scenario applies to the free version of ESXi.

1. Log in directly to the ESXi host through the VMware Host Client (via Web browser enter the IP
address/FQDN of the ESXi host).

2. Click Host and from the main menu, select Create/Register VM. A wizard opens that will assist in the
deployment process. in the first step, select the Creation Type and select Deploy a virtual machine
from an OVF or OVA file.

3. On the next page, specify a name for the virtual machine and select the OVF and VMDK files or the
OVA for the VM you want to deploy.

4. Select a data store for the virtual machine. It could be either local or centralized (SAN).

5. Map the networks used in this OVF to networks in your inventory, select disk format for the virtual
disks. Thick provisioning allocates all space at once, thin allocates on demand. Thick gives a slight
performance gain and eliminates the risk of over-shooting actual storage space.

6. You will get a summary page to review your settings selection before you exit the wizard and proceed
to start the deployment.

7. Click Finish to start the deployment task.

Importing on a Single ESXi host (From ESXI 6.0 Or Earlier)

This section describes how to install the MX-ONE Service Node Virtual Appliance on a
single VMware ESXi host through the vSphere client. This scenario applies to the free

version of ESXi.
1. Log in directly to the ESXi host through the vSphere client.
2. From the File menu, select Deploy OVF Template....

3. A wizard opens that will assist you with deployment process. In the first, select the Virtual Appliance
file. Next page shows some information about the Virtual Appliance.

Specify a name and location for the deployed template.
Select a data store for the virtual machine. It could be either local or centralized (SAN).
Select thick lazy zero provisioning as the disk format for the virtual disks.

Map the networks used in this OVF to networks in your inventory.

© N o o A

All done - click Finish to start the deployment task.
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IMPORTING INTO A VCENTER CLUSTER
CHAPTER 4 IMPORTING THE VIRTUAL APPLIANCE

Importing into a vCenter cluster

This section describes the import process of a MX-ONE Service Node Virtual Appliance in a VMware
vCenter cluster environment.

Such an environment contains multiple hosts, centralized storage, and distributed network and supports

the vCenter features such as vMotion, High Availability (HA), and Fault Tolerance (FT).

1. From the vSphere client or vSphere Web client, log on to the vCenter server.

2. Ifyou are importing on a vSphere client, select from the File menu and select Deploy OVF Template....
A wizard opens that guides you through the deployment process.Select the Virtual Appliance file to
import.

3. A page opens showing information about the Virtual Appliance.

a. Select the Virtual Appliance file to import. A page opens showing information about the Virtual
Appliance.
b. Enter a name for the virtual machine, and also, select the datacenter where it should be used.

c. Select the host or cluster that should handle the new virtual machine. A review page with data
about the Virtual Appliance is displayed.

4. Ifyou are importing on a vSphere Web client, right- click on the vCenter server and select Deploy OVF
Template.... A wizard opens that guides you through the deployment process.

a. Select the Virtual Appliance file to import.
b. Enter a name for the virtual machine, and also, select the datacenter where it must be used.

c. Selectthe host or cluster or resource pool or vapp where to run the new virtual machine. A review
page with data about the Virtual Appliance is displayed.

5. Select datastore for the virtual machine. Choose a centralized storage (SAN) if HA/FT will be used.

6. Select the virtual network the virtual machine must connect to. In a clustered environment, this is
normally a Distributed Switch. Be sure that switch is connected to the production/telephony network

7. Select the disk format for the virtual disks. If FT will be used, or thick provisioning must be selected.
For other cases, select any format (you can keep the default selected).

8. Select the virtual network the virtual machine must connect to. In a clustered environment, this is
normally a Distributed Switch. Be sure that switch is connected to the production/telephony network

9. With this all, necessary information is now collected. Click Finish to start the deployment task.

After you finish importing a Virtual Appliance by using a single ESXi host or a vCenter cluster, you will
have a MX-ONE Service Node in turnkey state. At this moment, the server is not yet configured and is
generic (it has not yet been assigned any specific function). Starting up the virtual machine triggers the
turnkey installation process, which is identical to the one used for physical MX-ONE servers. If more than
one MX-ONE Service Node is needed, just run the process above multiple times using the same Virtual
Appliance file. Give each virtual machine an unique name and distribute them over the hosts in the cluster
(how depends on the cluster setup, the amount of servers inside the cluster and the load on the hosts)
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CHAPTER 5 POST-CONFIGURATION OF A NEWLY IMPORTED MX-ONE VM

Post-Configuration of a Newly Imported
MX-ONE VM

Before using a newly imported MX-ONE virtual server, some settings must be considered and maybe
changed. These are mainly related to processor and memory allocation

e Hardware - Memory

The amount of memory the virtual machine is equipped with. The value must be changed according to
the system size and the MX-ONE application that the server will run, e.g. Service Node, Service Node
Manager, Database (Cassandra), Provisioning Manager and Media Server. For configuration and plan-
ning of virtualization, see the description VIRTUALIZATION FOR MIVOICE MX-ONE 7.0 or later.

» Hardware - CPU

By default, two CPUs are allocated to the virtual machine. If you plan to use Fault Tolerance together with
the MX-ONE Service Node, this must be changed up to 8 vCPUs. Also, numbers of CPUs needed in a
server depends on desired performance and system size. For configuration and planning of virtualization,
see the description VIRTUALIZATION FOR MIVOICE MX-ONE 7.0 or later.

« Options - Paravirtualization

This must be disabled on Fault Tolerance-enabled virtual machines as it is not supported. On all other
configurations, keep this enabled.

* Resources - CPU

This setting affects the resource allocation in the cluster/host. This must be configured to match required

performance of the MX-ONE and the capacity of the cluster/host and how many virtual machines are
running in parallel.

» Resources - Memory

As for the CPU-resources, this setting depends on the capacity needed, the cluster/host configuration and
how many other virtual machines are running in parallel.

» Disks

For database (Cassandra) server VMs co-located or stand-alone, SSD disks are required.

NOTE: Be sure that the network configuration of the virtual machines is properly set up in the cluster. By
default, the standard "VM Network" is used. In a cluster environment where distributed switches are used
(a requirement if HA/FT is used), this must certainly be changed.
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CHAPTER 6 INSTALLING MX-ONE ON HYPER-V

Installing MX-ONE on Hyper-V

The Microsoft hardware virtualization product, Hyper-V lets you create and run a software version of a
computer, called a virtual machine. Each virtual machine acts like a complete computer, running an oper-
ating system and programs. The following are the requirements of the virtual machine.

* It can be installed on Windows Server (2019, 2016)

» It requires only a Windows license and no specific license is required.

» Windows Server can be installed on a Dell or an HP server.lt is similar to VMware in its functioning.
» It uses .vhd and. vhdx format image for installation.

To install MX-ONE on a Hyper-V setup:

Once the Windows Server get successfully installed,
1. Enable Hyper-V using PowerShell.
a. Open a PowerShell console as Administrator.

b. Run Enable-WindowsOptionalFeature -Online -FeatureName Microsoft-Hyper-V
-A11 command to install Hyper-V.

EN¥ Administrator: Windows PowerShell - O *

2016 Microsoft Corporation. All rights reserved.

5 C:h\UsershAdministrator> Enable-WindowsOptionalFeature Mi crosoft-Hyper-V
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CHAPTER 6 INSTALLING MX-ONE ON HYPER-V

c. Oryou can open the service manager - Add role and features and install Hyper-V.

Server Manager * Dashboard

Dashboard

B Local Server

WELCOME TO SERVER MANAGER

§ All Servers

Tt ) 0 Configure this local server
W§ File and Storage Services b =

B Hyper-v QUICK START

= Add Roles and Features Wizard — O *

Select server roles

Befors You Begin Select ane or more roles to install on the selected server.

Installation Type Roles Description

Server Selection

MY~ ctive Directory Certificate Service

[] Active Directory Domain Services

Active Directory Certificate Services
(AD CS) is used to create

certification authorities and related
role services that allow you to issue
and manage certificates used in a
variety of applications.

[] Active Directory Federation Services

[] Active Directory Lightweight Directory Services
[] Active Directory Rights Management Services
[] Device Health Attestation

[] DHCP Server

[] DNS Server

[ Fax Server

[ File and Storage Services (1 of 12 installed)

[C] Host Guardian Service

Manageability

| Hyper-V (Installed) Events

[] MuttiPoint Services

[] Network Policy and Access Services I Services

[ Print and Document Services

[] Remote Access Performance
[] Remote Desktop Services ‘ BPA results

[ Volume Activation Services
] Web Server {IIS)
] Windows Deployment Services

1/29/2019 AM

Install

s Server Manager

Server Manager * Dashboard

Dashboard

§ Local Server

'WELCOME TO SERVER MANAGER

All Servers

= ; o Configure this local server
W% File and Storage Services b =2

H Hyper-v QUICK START
2 Add roles and f
3 Add other servers to manage
WHAT'S NEW A raan
4 Create a server group
5 Connect this server to cloud services
LEARN MORE
ROLES AND SERVER GROUPS
Roles:2 | Servergroups: 1 | Servers totali 1
=g File and Storage [
[ i Hyper-V 1 1
o Services m yper
@ Manageability (@ Manageability ‘ @ Manageability ‘ ‘ (@ Manageability
B Hyper-V Manager T T o T - X

File Action View Help
«9|zHE
[ Hyper-V Manager

Virtual Machi ;
X irtual Machines
[l WIN-3SMLITLAMDG T T
MName State CPUUsage  Assigned Memory  Uptime Status Configurati.
New »

No vitual machines were found on this server [ Import Virtual Machine,

[] Hyper-V Settings..

g3 virtual Switch Manager...
2. Vittual SAN Manager.
Edit Disk..

Inspect Disk..

Stop Service

Remove Server

eX®™ih

Refresh
View »

Help
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CHAPTER 6 INSTALLING MX-ONE ON HYPER-V

2. Before you install, create a Virtual Switch Manager for Hyper-V to give network access to the virtual
machines.

3. Select Virtual Switch Manager from the right pane.

& Hyper-V Manager
File Action View Help

5| 5m HE

No vitual machines were found on this server.

Hyper-V Manager Actions
e 2 Virtual Machi
Bl WIN-SIMLTLAMDG WIN-35MLITLAMDG
Name State CPUUsage  Assigned Memory  Uptime Status Configurat "
ew

[ Import Virtual Machine.

[ Hyper-V Settings.

23 Virtual Switch Manager.
. Virtual SAN Manager..

4 Edit Disk.

5 Inspect Disk.
m) Stop Service
K Remove Server
© Refresh

View
B Hep
4. Select the type of switch, in this case, an External Switch.
B Hyper-V Manager ) a8
File Action View Help
«=| #m Hm
BE Hyper-V Monager e e
. ST
E WIN-35MLI7LAMDG WIM'S‘S,MLDLWM
Grw: || Co0Umges |[dipeimeny [Uphime || [fosis Confgra
New
No vitual machines were found on this server. [ Import Virtual Machine
48 Virtual Switch Manager for WIN-3SMLITLAMDG - [1 Hyper-V settings.
8 Virtual Switch Manager
2 Create virtual switch s Virtual SAN Manager.
What type of virtual switch do you want to areate? s Edit Disk...
L Inspect Disk.
& Global Network Settings &) Stop Senvice
U MAC Address Range Private P
00-15-5D-21-17-00 to 00-15-5D-2 ¥ Remove Server
© Refresh
Create Virtual Switch View:
Creates a virtualsnitch that binds to the physical network adapter 5o that virtual Help
machines can access a physical network.
| Checkpoints Q)
‘ Details.
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CHAPTER 6 INSTALLING MX-ONE ON HYPER-V

5. Enter a Name for your switch and click Apply.

B8 Hyper-V Manager

- X
File Action View Help
«=| 25 &
[ Hyper-V Manager - - Actions.
[ WIN-35MLITLAMDG it Mackines N
Name State CPUUsage  Assigned Memory  Uptime Status Configurati...
MNew »
No vitual machines were found o tis server. B Import Virtusl Machine.
2 Virtual Switch Manager for WIN-35MLITLAMDG - X [] Hyper-V ettings..
F2 Virtual Switch Manager..
% =5 per 1w Virtual SAN Manager.
New virtual network switch
Gigabit Ether. Name: s EditDisk.
Sroadcon NetXreme Gigabit Ether... | [New Virtual Switch | 5 Inspect Disk.
o New Virtual Switch
Broadcom NetXtreme Gigabit ... W= @ Stop Service
2 _Global Network Settings X Remove Server
§ MAC address Range © Rt
00-15-5D-21-17-00 t 00-15-50-2.
View »
Connecton type
What do you want to connect this vrtual switch to? B nee
® Externalnetwork:
Broadcom NetXtreme Gigabit Ethernet ~
system to share this
] Enable single 700t 1/0 vir ualization (SR-10V)
O Internal network.
O Private network
VLANID
[] Enable virtual LAN identification for management operating system
2|
Remove
@ 5ROV can orly be configured when the virtual switch is created. An external
virtual switch with SR-IOV enabled cannot be converted to an internal or private: ~
Checkpoints ®
}u.mk Cancel Aoply %
L& Metwork Connections - m} x
T .E‘-' » Control Panel » Metwork and Internet » Network Connections v O Search Network Connections @
Organize « Disable this network device Diagnose this connection Rename this connection View status of this connection Change settings of this connection | 0
"'-h MICT ""h NIC2 —~ vEthernet (Broadcom MetXtreme
3 Enabled § MNetwork cable unplugged Gigabit Ethernet - Virtual Switch)
& Broadcom NetXtreme Gigabit Eth... K @ Broadcom NetXtreme Gigabit Eth... & Network 2
HE Hyper-V Manager - X
File Action View Help
«=|zm E6
BE Hyper v Manager IF - e
B WIN 2510 m auine Virtual Machines NS HLTLAMDG L
(= i R TPUUsage  AssignedMemory  Uptime Status. Configurati,
Import Virtual Machine. Hard Disk. New >
T Floppy Disk.. No vitual machines wers found onthis server. B Import Virtual Machine.
Virtual Switch Manager. [3 Hyper-V ettings.
Virtusl SAN Manager. E2 Virtual Switch Manager.
it Disk 4. Virtual SAN Manager.
Inspect Disk. «a EditDisk.
Ston s 2 Inspect Disk.
op Service
Remove Server &) Stop Service
Refresh X Remove Server
Vi N O Refresh
View »
Helj
* H ‘ [ Hep

10
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CHAPTER 6

INSTALLING MX-ONE ON HYPER-V

9. Enter the virtual instance name and click Next.

B8 Hyper-V Manager - %
Fie Action View Help
| anm Bim
[ Hyper-V Manager - - Actions.
BB WIN-35MLTLAMDG Yirtual Maclines WIN-35MLITLAMDG -
Name State CPUUsage  AssignedMemory  Uptime Status Configurati " R
lew
No vitusl machines were found on ths server. % Import Virtusl Machine
[] Hyper-V Settings...
E2 Virtual Switch Manager.
. Virtual SAN Manager.
30 New Virtual Machine Wizard wa  Edit Disk..
& Inspect Disk.
(=) Stop Senvice
=@ Specify Name and Location
K Remove Server
U Refresh
Before You Beon Choase a name and location for this vrtual madhne. View »
The Manager, that you use a name that helps you sasily H Hep
Specify Generation identry ., such as the name of the system or workload.
J— Nome: [oNELT]
EolErRiEnziing You can creste a folder or use an existing folder to store the virtual machine. If you don't select a
G Ee folder, the virtual machine & stored in the default foder confiured for this erver.
Installation Options [ Store the virtual machine in a different location
Summary C1ProgramData\Marosoftindows iyper ¥y Browse.n
<Previous Fnish Cancel
Checkpoints
18 Hyper-V Manager - o ox
File Action View Help
= 5 B
FEF Hyper-V Manager - - ‘Actions
BB WN-35MUTLAMDG Virtual Mactines WIN-35MLITLAMDG N
Name State CPUUsage  Assigned Memory  Uptime Status Configurati N R
No vitual machines were found on ths server. . Import Virtuol Machine..
[ Hyper-V Settings.
2 Virtual Switch Manager..
o, Virtual SAN Manager
E New Virtual Machine Wizard 4 Edit Disk.
Inspect Disk.
Stop Service
= Assign Memory N S
Refresh
Before You Beon Specify the amount of memory to allocate to this virtual machine. You can speciy an amount from 32 View >
N MB thvough 12582912 MB. To inprave performance, pecify mere than the minmum amoun
n aperatng system. B Hep
Specify Generation —
Use Dynamic Memory for this virtusl machine.
Configure Netwarking W= i
R when you 10 as5ign 10 2 virtual machi der how you ntend to
Connect Vsl ard Disk O s e e o
Installation Options
Summary
< previous Firich Cancel
Checkpoints ®
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CHAPTER 6 INSTALLING MX-ONE ON HYPER-V

11. Select the Network Switch which you have configured initially and click Next.

[ Hyper - & X
Fie Action View Help
LI AR:aNeall 7 )i
F Hyper-V Manager - Actions
[l WIN-35MLITLAMDG it bachines WINSMLUTLAMDG .
Name State CPUUsage  Assigned Memory  Uptime Status Configurati e =
New »
No vitusl machines wers found on this servr. %y Import Virtual Machine...
[ Hyper-V Settings.
g3 virtual Switch Manager...
. Virtual SAN Manager.
New Virtual Machine Wizard X o EdmDE,
5 Inspect Disk.
u) Stop Sewvice
@ Configure Networking
X RemoveServer
® Refresh
Before You Begin Each new virtual machine indudes  netuork adapter. You can configure the network adapter to use View »
virtual switch, o it can remain dscomnected.
Specy Neme and Location Help
Specy Generation Connection: [Not Connected ~
Assign Memory ¥
Installation Options
Sunmary
| <previous | Ensh | [ cancd
| Checkpoints &

12
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CHAPTER 6 INSTALLING MX-ONE ON HYPER-V

12. Select the image (VHD) by selecting the option, Use an existing virtual Hard disk and select the
location where your VHD image is stored (In case of MX-ONE Unzip the Hyper-V Image and select

13
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CHAPTER 6 INSTALLING MX-ONE ON HYPER-V

the Virtual Hard Disk ).

B8 Hyper-V Manager
File Action View Help

= nm B
[ Hyper-V Manager
B WIN-35MLITLAMDG B
Name State CPUUsage  Assigned Memory  Uptime Status Configurati..
No virtual machines wers found on this server.
[ New Virtual Machine Wizard X
=) Connect Virtual Hard Disk
Before You Begin A virtual machine requires storage s that you can install an operating system. You can spedify the
N —— storage now or configure it later by modifying the virtual machine’s properties.
Specify Generation () Create a virtual hard disk
P v Use this option to create @ VHDX dynamically expanding virtual hard disk.
Configure Networking MName: | MX-ONE-LIM1.vhdx
tion: | C:\Users\Public\Documents\Hyper 4 \Virtual Hard Disks\ Browse..
Summary
Size: 127 GB (Maximum: 64 TB)
(®) Use an existing virtual hard disk
Use this option to attach an existing virtual hard disk, either YHD or VHDX format.
SWX-ONE_7.1.5p0.hf0.rc10.vhd
() Attach a virtual hard disk later
Use this option to skip this step now and attach an existing virtual hard disk later.
<previous | [ Mextz || Fnsh | Cancel
Chorlmninte =
B8 Hyper-v Manager
File Action View Help
L ANAY
[ Hyper-V Manager
£ WIN-35MLITLAMDG LT
Name State CPUUsage  Assigned Memory  Uptime Status Configurati.
No virtual machines were found on this server.
3 open kS
« « 4 |5 ThisPC s Desktop » HyperV-Image-MX-ONE 7.1.5p0.hfllrc10 5 Virtual Hard Disks v ©  Search Virtual Hard Disks P
Organize * Mew folder -~ O @
Name Date modified Type Size
# Quick access
o MX-ONE 7.1.5p0.hf0.1c10 1/28/2019 10:46 AM  Hard Disk Image F... 12,161,024 ..
I Desktop » el & =
& Downloads
Documents
& Pictures b4
Virtual hard disks
[& Microsoft Managem:
[ This PC
Local Disk ()
¥ Network
File name: | MX-ONE_7.1.5p0.hf0.rc10 | | Virtual hard diskcfles v
Checknoints ! -

14
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CHAPTER 6

INSTALLING MX-ONE ON HYPER-V

Ha Hyper-V Manager

File Action View Help

LK A= ]l
R Hyper-v Manager
Bl WIN-35MLITLAMDG R, TEEE
Name State CPUUsage  Assigned} :mory  Uptime Status Configurati..
No virtual machines were found on this server
EH New Virtual Machine Wizard X
Completing the New Virtual Machine Wizard
Before You Begin YYou have successfully completed the New Virtual Machine Wizard. You are about to create the
I — following virtual machine.
Speafy Generation Bl
Assign Memary Hame: MX-OME-LIM1
Configure Networking Generation: Generation 1
Memory: 8000 MB
Connect Vir ual Hard Disk Network:  Broadcom NetXireme Gigabit Ethernet - Virtual Switch
ST | o0k CiUsers\Administrator\DesktopHyperV-Image-MX-ONE_7. 1.5p0.hf0.rc 10Wirtual Hard
< >
To reate the virtual machine and dese the wizard, ciick Finish.
<Previous Next > Fiish | | Cancel
[PE——
B8 Hyper-v Manager
File Action View Help
= nm
R Hyper-V Manager
R wiN-QaLOsK123,T Virtual Machines
Narme State CPUUsage  Assigned Memory  Uptime Status Configurati...
B mxonELM Running 0% 2000 MB 0001:06 20
{4 Settings for MX-ONE-LIM1 on WIN-QLOSK123JT -
[ Mo-ONE-LIMT “] 4 » O
#_Hardware * | B AddHardware
05 ‘You can use this setting to add devices to your virtuzl machine
Boot from €D Select the devices you want to add and dick the Add button.
@ searity SCSI Cantroller
Key Storage Drive disabled Metwork Adapter
W Memory RemateFs 30 Viden Adapter
8000 ME Legacy Netvork Adapter
[ Processor Fibre: Channel Adapter
1 Virtual processor
(= [l IDE Controller 0 Adkd
s Hard Drive
MX-ONE_7, Lsp0.hf,re10.
Checkpoints. = [ 1DE Controller 1
() DVD Drive
None.
&l 551 Controller
1§ Network Adapter
New virtu; itch
i@ comi
Mone
@ comz
None
[ Diskette Drive
None
& Management
L] mame
MX-ONE-LIM1
[] Integration Services
Some services offered
(&8 Chedepoints
Production
& Smart Paging File Location
C:\ProgramData MicrosoftiWin...
}“" C= 0 e |
— s A
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CHAPTER 6

INSTALLING MX-ONE ON HYPER-V

14. Start the machine and install MX-ONE setup as shown in the following figures.

i
File Action View Help
@=|7FE HE
EF Hyper-V Manager

E WIN-33MLI7LAMDG

File Action View Help
| nm

& Hyper-V Manager

£ WX-ONE-LIM1 on WIN-35MLITLAMDG - Virtual Machine Connection -

File Action Media Clipboard View Help
Virtual Ma| £ @O PR

GNU GRUB wversion 2.02

P4
Advanced options for SLES 1

Use the 1 and § keys to select uhich entry is highlighted.
Press enter to boot the selected 0S, ‘e’ to edit the commands
before booting or "¢’ for a command-ling.

The highlighted entry will be executed automatically in 3s.

Status: Running

Configurati.
30

E7 MXOMNE on WIN-QSLO5K123JT - Virtual Machine Connection

Bl WiN-0oL05k1z3y7| File Action Media Cliphozrd View Help

D@0 | n |k

MX-ONE Initial Setup
Welcome to MX-ONE Telephowy System Setup

You have to configure your server before starting
the Telephony Systen.
Do you want to configure your server now?

< No >

28/1531-ANF 901 14 Uen E 2022-04-13

Actions
WIN-35MLITLAMDG
New
% Import Virtual M
7 Hyper-V Settings
Y8 Virtual Switch Mz
Virtual SAN Manz
Edit Disk.
& Inspect Disk..
) Stop Service
X Remove Server
© Refresh
View
H Hep
MX-ONE-LIM1
oF Connect...
F9 settings..
®) Tum Off..
® ShutDown.

O Ssove
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File Action View Help

INSTALLING MX-ONE ON HYPER-V

| 2@ HE
B Hyper-V Manager
Eg WiN-QaLOsKiz3yT| Flle Action Media Clipboerd View Help

@O | np|f

B3 MXONE on WIN-QILOS5K123JT - Virtual Machine Connection

MX-ONE Initial Setup
Successful restart of netuork
service

Missing servers will not be included if you choose to continue
They can be added later

Mait for expected server(s) to appear
Heu server data file(s) received from:
mxone-1inl.mitel.con

[Press ¢ to continue

Status: Running

File Action View Help

=55 HE
Hyper-V Manager
E&;FW‘N_QM%B” File Action Media Clipboard View Help
B D@0 nn

1[1] mxone-linl.mitel.com

B MXONE on WIN-Q8LOSK123IT - Virtual Machine Connection

[Executing:
cassandra_sn createTables, schena file=-optreri_sn 17.1.8.0. 1 ctconxone_cql.schema
ok

[Execut in
| -opt-mxone_install,7.1.0.0. 1 target-install_scripts/serviceNode “insertConf igDataInDB”
Inserting Alarn Configuration into database
Inserting default domain data into database

(3
[Executing “start” in all servers

Ack from mxone-liml.mitel.con
pait for 1 ansuwers.

Ansuer received from:

1011 mxome-linl.mitel.com
Distribute server data to other servers

ok
lait for LIM(s) to start
i ime: 11 minutes

[Executing config_mirror
cont ig_mirror ok

SR SR I SR R A R R R S SR R R
#* #*

# OBSERVE!? To get correct group membership logout and in again. #

# #
PR ORI SRR SR R SR AT SRR SO R SR RO

Installing addon softuare
Installing MX-ONE Service Node Manager - please wait ...
[starting silent installation of mxone_snm rpm

[Follow progress by opening another shell and type:
tail —f —n B svar.log/mxone uebserver application_log. log

fcreated synlink from setcssystendssystensmulti-user . target.vants/mxone_jboss.service to ~usr-1ib-systend system/mxone_jboss.service.

Installation of M¥-ONE Service Node Manager is finmished.
jiebserver will now be re-started. This may take a while.
Sce progress i

opt~ jhoss/standalones log server . log
[Finished. See log file -var-logmxonesuebserver application_log.log for details.
Updating serverData.conf

Installation finished successfully

1inux—Z44m:~ #
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Actions
WIN-Q9LOSK123/T

New

%, Import Virtual Machine..

Hyper-V Settings...

& Virtual Switch Manager...

s EditDisk..
£ Inspect Disk...
=) Stop Senvice
% Remove Server
© Refresh

View

H Hep

48 Connect...
E7 Settings...

=) Tum Off...

@ Shut Down..
O save

1 Pause

Ib Reset

By Checkpoint

B Move..

B Export.

T Rename..

H0 Encble Replication.

H Hep

. Virtual SAN Manager...
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Installing MX-ONE KVM, SuSE Linux

To install MX-ONE on the Kernel-based Virtual Machine (KVM) on the SUSE Linux platform, follow these
steps:

Download the MX-ONE ISO image (Recovery image) from the MX-ONE repository.

Make a bootable USB and load it with the Recovery image to install OS with KVM capability.

Run the USB and select option 3 (KVM install).

Install the KVM image and system is restored with SUSE Linux installed.

1.
2,
3.
4,
5.

Enter the root login credentials.

6. Using the Yast utility, enter IP address, Gateway, DNS and subnet Mask to the system. For more infor-
mation see,
https://www.suse.com/documentation/sled11/book_sle admin/index.html?page=/documentation/sle
d11/book_sle admin/data/sec_basicnet yast.html.

99999999999999999999IIIIIIIIIIITIIITITITIIIIIIITIIL

x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x

7. Using the configured IP address login to the terminal using pultty.

8. For the installation of KVM over SUSE download the. gcow2 and .xml files from the package reposi-
tory.
9. Check if 1ibvirtd is running or not, else start it: sudo systemctl status libvirtd

libvirtd.service - Virtualization daemon Loaded: loaded
(/usr/lib/systemd/system/libvirtd.service; enabled; vendor preset:
enabled) Active: active (running) since Mon 2019-04-08 14:38:40 CEST;
22h ago Docs: man:libvirtd(8) https://libvirt.org Main PID:

18
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21036 (libvirtd) Tasks: 18 (limit: 32768) CGroup:
/system.slice/libvirtd.service 2221036 /usr/sbin/libvirtd -listen
10. Create a virtual machine, enter virt-clone --original-xml Virtu-
al Image-MX-ONE 7.0.spO.hf2.rc5.xml --name <your system name> --file
/local/images/<your system name>.gcow2

Forexample,virt-clone --original-xml Virtual Image-MX-ONE 7.1.sp0.hf0.rc26.xml
--name MX-ONE --file /local/MX-ONE.gcow2

NOTE: Keep the qcow2 and xml under the local folder. Edit (vi) the xml file and change the default
path from /kvm/images to /local where you have saved the image file.

11. When the kvm image installation is complete, create a network bridge and map it to the etho0 that you
are using so that KVM can access it.

12. To add a new network bridge device on VM Host Server with brct1, follow these steps:

a. Log in as root on the VM Host Server where you want to create a new network bridge.

b. Choose a name for the new bridge-VIRBR_TEST in our example- and run root # brctl
addbr VIRBR TEST.

c. Check if the bridge was created on VM Host Server root # brctl show

bridge name bridge id STP enabled interfacesbr0
8000.e06995ec09%e8 no ethOvirbr0 8000.525400b37ec9
yes virbrO-nicvirbr test 8000.000000000000 no

NOTE: virbr test is listed, but not associated with any physical network interface

d. Add a network interface to the bridge using root # brctl addif VIRBR TEST ethl
command.

NOTE: Network interface must not be already in use. This is because you can only enslave a
network interface that is not yet used by other network bridge.

e. Optionally, enable STP using root # brctl stp VIRBR TEST on command.

For more information, see https://www.suse.com/documentation/sles-12/book_virt/data/libvirt -
networks_bridged.html.

brctl showbridge name bridge id STP enabled
interfacesbr0 8000.28b9d%¢09f41 no eth0
vnet0

13. To start your virtual machine, install Mobaxterm (GUI or X server support). See https://mobax-
term.mobatek.net/download-home-edition.html

14. Run KVM machine and run virt-manager on the command line.

B root@linu-2dm- ] b
View Xsever Tools Games Settings Macros Help

¥ =E Y @& & @ il

& Games Sessons  View Spit  MuliExec Tunneing Packsges Settings el Xserver  Exit

D A Macros & Tools
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15. This gives you the virtual manager access through which you, start, stop, or change the MX-ONE
deployed KVM and install it.

" Virtual Machine Manager@linux-2drw - x
Flle Edit View Help
Open 0 -~
v QEMUAKVM
& MX-ONE on QEMU/KVM@linux-2drw - ¢

Fle virtual Machine View Send Key

U - | &

[
# OBSERUE!? To get correct group membership logout and in again. #

g g
R R R R R R R R R
Installing addon sof tuare

Installing MX-ONE Service Node Manager - please uait ...

Starting silent installation of mxone_snm rpm
Follow progress by opening another shell and
“n 8 /var/lug/mxm\e/uebserller/applu:atlon log. log

eated synlink from setc systend-systenmulti-user.target.uants mxone_jboss.service to susrs1ibssystend systensmxone_jboss .seru
ice
Installation of MX-ONE Service Node Manager is finished.
Uebserver will now be re-started. This may take a uhile.
See progress in:
sopt~ jbasssstandalones logsserver. lag
Finished. See log file svarslogsmxone uchserver-application_lag.log for details.
Updating serverData.conf

Installation finished successfully
linux—BmBy:~ # bretl show

If ’brctl” is mot a typo you can use command-not-found to lookup the package that contains it, like this:
cnf bretl

211, 91 31 Bcast 10.211.91. 255 Hask:255.255.255.0
inet6 addr: feB0 829,64 Scope:Link
UP BROADCAST RIJNHIH(‘ nuLTImST HTlI 1500 Metric:l
BX packets:4158 e 967 overruns:0 frame:0
X packets:147 errors:0 drnpped:ﬂ overruns:0 carrier:@
collisions:0 txqueuelen: 1008
RX bytes:338988 (331.0 Kb TX bytes:23457 (22.9 Kby

Link encay anal Lnnplmck
inet add: Mask:255.0.0.0
inet6 atlllr 1/125 Scope :Host

UP LOOPBACK RUNNING HTU:65536 Hetric:i

B carrier:0
collisions:0 txqueuelen:1000
RX bytes:1539903Z (14.6 Mb) TX bytes:15399032 (14.6 Mb)

Linux-BnBy:~ #

16. Executables are stored in /usr/libexe.
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Installing MX-ONE KVM on Redhat-Linux

To install Kernel-based Virtual Machine (KVM) on Redhat-Linux, follow these steps:
1. Install the Redhat-7.6 OS through a bootable pen-drive or any other external media.
2. Create a bridge interface; for example, i fcfg-br0.

NOTE: For configuration details, see Network Bridge.

3. Copy the Mx-0ONE .gcow?2 image to the host machine to continue installation. See Creating a VM by
Importing an MX-ONE qcow?2 Image for installation instructions.

Creating a VM by Importing an MX-ONE gcow2 Image

To create a virtual machine (VM) by importing an MX-ONE gcow?2 image, follow these steps:
1. Log in to your machine as root user.
2. Navigate to the directory of the installation files previously downloaded.

NOTE: Create a backup copy of the image file.
3. Move the image file to the directory where you want to place the virtual machine.

4. Start the Virtual Manager and click Create a new virtual machine
L

5. Select Import existing disk image and click Forward. See Create a new virtual machine screen for
details.

Figure 8.1: Create a new virtual machine screen

m Create a new virtual machine

Connection: QEMU/KVM

Choose how you would like to install the operating system
Local install media (ISO image or CDROM)
Network Install (HTTP, FTP, or NFS)
Network Boot (PXE)
o) Import existing disk image

w Architecture options

Architecture: | x86_64 »

Cancel E Forward

6. Click Browse and navigate to the path of the image file.

7. Select the image file and select the operating system type and version from the following fields and
click Forward. See Selecting the OS and version for details.

- OS type
— Version
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CHAPTER 8

m Create a new virtual machine

Selecting the OS and version

8. Complete the following fields and click Forward (see Memory and CPU settings for details):

- Memory (RAM)
- CPUs

Provide the existing storage path:
‘ flocalfimages/new_machine.qcow2 Browse... ‘
Choose an operating system type and version
0S type: | Linux -
\ersion: | SUSE Linux Enterprise ¢ | «
Cancel ‘ ‘ Back | ! Forward ‘

NOTE: For the memory and CPU settings, specify values that match your system. For the purposes
of this procedure, the values 6 GB RAM (6144 MB) and 2 CPUs are specified.

Figure 8.2: Memory and CPU settings
m Create a new virtual machine

Choose Memory and CPU settings

Memory (RAM): | 144 ] [

Up to 96255 MIB available on the host

CPUs: | 2| +

Up to 12 available

i Cancel ‘ Back
| @

9. Click Finish. See Creating a VM for details.
The details of the VM to be created are displayed.

Forward
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Figure 8.3: Creating a VM

m Create a new virtual machine

Ready to begin the installation

Storage: /local/images/new_machine.qcow2

Name: | new_maching|

0S: SUSE Linux Enterprise Server 12 SP4

Install: Import existing OS image
Memory: 6144 MiB

CPUs: 2

Iz Customize configuration before install

» Network selection

Cancel

‘ Back

Finish

10. Click Begin Installation. The virtual machine is created. See Begin Installation for details.

</ Begin Installation

Figure 8.4: Begin Installation

!J Cancel Installation

Sh8a0ad2-a93b-41c8-base-5e56bf8c2533

E!. Overview Basic Details
& CPUs Name: new_machine
== Memory uuiD:
& Boot Options Status: B shutoff (Shut Down)
[ \irtlO Disk 1
=V = Title:
B NIC :80:02:3d _
Description:

|1| Tablet
! Display Spice

HF Sound ich6

= Console

@ Channel gemu-ga Hypervisor: KVM
£~ Channel spice Architecture: x86_64
L!I Video QXL Emulator: fusr/bin/gemu-kvm
= Firmware:
B8 controller use 0 ‘ BIOS
) USB Redirector 1 i ; 7
& ' Ehipzee ‘ i440FX v ‘

@ USB Redirector 2
é%i} RNG jdevjurandom

Hypervisor Details

11. Use the Mobaxterm (GUI or X server support). to open a virtual manager session. See Virtual Machine

Manager for details.
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Figure 8.5: Virtual Machine Manager

hd
¥ Virtual Machine Manager@localhost.localdomain = O X

File Edit View Help

(™ Bl Open , n ~
Name v CPU usage
v QEMU/KVM

“ MXONE-KVM-REDHAT
Running |
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Installing and Configuring MX-ONE

With all the virtual MX-ONE servers in place and configured, it is time to build a PBX out of them. The
procedure of setting up the system is the same as for physical MX-ONE servers loaded with turnkey
installations. The difference lays in the access of the MX-ONE servers that is done through the vSphere
client.

For more details see INSTALLING AND CONFIGURING MIVOICE MX-ONE.
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